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Release Notes 

Thank you for upgrading to the latest version of CADS A3D MAX. 

These release notes summarise the enhancements and corrections made. 

Version 4.51 (Build 791): April 2018 

Enhancements: 

1. Export of members to IFC (2x3) Format is now supported. 

Corrections made:            

1. In previous version, a spurious message was displayed when haunch sections with automatic self-
weight selected was checked/designed. This has now been corrected. 

2. Various issues in integrated design of steel members to Eurocode 3 have now been fixed. 

3. Licensing issue related to integrated design of members according to Eurocode is now fixed. 

4. Slow boot-up problem is now fixed. 

Version 4.50 (Build 775): November 2017 

Enhancements: 

1. Cloud licensing is now supported. 

2. Branding and icons have been updated. 

3. CADS A3D MAX now calculates the self-weight of steelwork haunches. 

4. Integrated design of steel members to Eurocode 3, now identifies Effective Class 2 webs. 

5. Integrated design of steel members to Eurocode 3, now supports Class 4 haunches. 

6. Integrated design of steel members to Eurocode 3, has an improved restraints defining option. 

Corrections made:            

1. In the classic user interface, the toolbar position reverted to the default position whenever it was 
re-opened. This has now been fixed. 

2. A3D MAX crashed while stretching nodes in the last released version. This has now been fixed.  
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3. Bending moments for angle sections were calculated incorrectly in the integrated design of steel 
members to the steelwork Eurocode (EN 1993-1-1) as part of A3D MAX. This has now been fixed. 

4. Various issues in integrated design of steel members to Eurocode 3 have now been fixed. 

Version 4.40 (Build 747): June 2017 

Enhancements: 

1. CADS A3D MAX now supports the Irish National Annexes to the Eurocodes. 

2. Integrated design of steel members to the steelwork Eurocode (EN 1993-1-1) as part of A3D MAX 
now allows you to define restraints to better define the cantilever condition. The restraint 
connection at free ends can be defined as 'none'. 

Corrections made:  

1. In certain circumstances the program crashed when changing panel loads. This is now fixed.  

2. Under certain circumstances when using the split member option, the member length became 
less than the loaded length causing an error during analysis. This is now fixed. 

3. An ambiguous warning message was given when plastic analysis failed to initiate due to invalid 
plastic limits. This is now corrected. 

4. Saving an A3D MAX job (.a3m) using the ‘Save As’ option in the ‘File’ menu didn’t copy the details 
file folder. This is now corrected. 

5. In certain circumstances the program crashed when a CSV file was imported. This is fixed now.  

6. Under certain circumstances the program crashed when overhang display toggle was clicked. This 
is now fixed. 

7. Print preview when invoked sometimes caused a crash. This is now fixed. 

8. In the integrated design of steel members to Eurocode 3 (EN 1993-1-1) as part of A3D MAX a 
proper warning message is now given to denote that Class 4 haunched sections are not supported 
in this version. 

9. The aspect ratio of the company logo in the report header is maintained according to the size of 
the logo.  

10. Only Admin users were able to edit the page margins in the report. This restriction is now 
removed. 

11. In the integrated design of steel members to Eurocode 3 for Class 1/Class 2 channel sections elastic 
properties instead of plastic properties were used in combined strength checks. This is now 
corrected. 

12. In the integrated design of steel members to Eurocode 3, an amendment to ignore very small 
torsions has been introduced. Torsion moments less than 0.1 kNm are now ignored. 
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Version 4.30 (Build 740): November 2016 

Enhancements: 

CADS A3D MAX now features a modern task-oriented easy-access ribbon interface of familiar tools 
and commands with brand new icons and tool tips. The classic menus and toolbars are still optionally 
available for those who prefer to continue using them. 

 

Corrections made: 

3. An issue exporting to SWMC where a single sided connection, other than to column flange and 
concrete base, was incorrectly exported is now fixed by terminating the export (as the applied 
moment causes torsion in the support member which usually cannot be sustained). 

4. A tolerance issue with EC3 check in assigning end restraints to design members made from 
multiple inclined segments has been resolved. 

5. A message from tension-compression analysis has been improved to notify the reference number 
of any member that is being removed due to buckling.  

6. Due to the limitations of automatic tension-only analysis, the analysis cannot proceed if any 
tension-only members are directly loaded. Formerly this meant that the analysis was prevented 
in all load combinations selected for tension-only analysis. This has been amended so that if the 
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relevant loads have zero partial safety factor in a combination (i.e. they are not included) the 
analysis for that load combination can proceed. 

 

Version 4.21 (Build 714): December 2015 

Enhancements: 

1. CADS A3D MAX is now compatible with Windows 10. 

2. Pin-ended members removed during p-delta analysis due to Euler buckling are now notified in the 
error log. 

3. The speed of creating design groups has been considerably improved. A large model with 5000 
members now takes only a few seconds to create a design group. 

4. The tolerance for checking compatibility of end 2 effects and displacements has been relaxed to 
avoid spurious warnings of “large differences in displacements” and “end 2 effects error” when 
the actual misclosure is trivial. 

Corrections made: 

1. A crash on selecting the anchor joint while trying to copy and paste joints without selecting 
members has been fixed. 

2. An issue whereby the vertical scroll bar did not appear in the design and check results dialog under 
some circumstances has been fixed. 

3. A defect in the computation of the torsional constant for the Elements section type for hollow 
cross-section shapes with depth less than breadth has been fixed. 

4. An issue with DXF creation in a large customer model has been fixed. 

5. An issue with p-delta analysis where no member effects were reported for a particular 
combination and a particular member has been fixed. 

6. An issue with printing the model using the hidden wire frame option is resolved. 

7. A tolerance issue with assigning end restraints for slightly curved members in Eurocode steel check 
is resolved. 

8. An issue with the Eurocode steel check which failed to produce results for certain members is now 
resolved. 

Version 4.20 (Build 669): November 2014 

Enhancements: 

1. Rectangular and circular grid tools have now been added to the software. Multiple grids of 
specified spacing can be added in the X, Y or Z planes and can be rotated, allowing for complex 
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structure layouts. Members will snap to grid intersections, thus reducing the labour of manual 
node creation and enabling faster modelling. 

2. Quick member tools in X, Y and Z direction have now been added. Whereas the main quick 
member tool requires two nodes to be selected in the model (the member is created connecting 
the two) the quick members in X, Y or Z tools require the height or length of the member to be 
specified before selecting the start node, thus members can be created without a second node 
being specified. These features go hand-in-hand with the new grid features as members can snap 
to grid intersections, allowing for fast creation of columns from the grid up, or beams, where no 
second node exists. It is now possible to create a vertical member to correctly intersect a sloping 
member such as a rafter without first splitting the rafter. 

3. Improvements to panel overhang loads; 

a. An improved approximate method of panel overhang distribution has been introduced, 
now accounting for cantilever/anchor span effects on the member supporting the 
overhang.  

b. Two additional load types are now supported for panel overhangs – edge line loads and 
point loads.  

4. A new item has been added to the print layout dialog to view or print reaction envelopes. This 
feature can be used to quickly obtain the maximum and minimum reaction in each direction for 
the given combinations;  

5. RC beam batch design: 

a. It is now possible to define pre-set covers in the template for RC beam batch design; 

b. A named template can be assigned to a group of beams without the template name being 
generated automatically by the software. You can choose a name; 

c. It is now possible to edit a specified template assigned to a group of beams without the 
template name being updated automatically by the software. You can choose a name; 

6. Default column end fixities can now be overridden during RC column batch design; 

7. The Eurocode EC3 steel check for deflections has been improved to include sway deflections. The 
following sets of deflections are now checked by the software: 

a. Deflection relative to end 1; 

b. Deflection relative to end 2; 

c. Local bow deflection 

8. In the print layout dialog it is now possible to select multiple combinations using ctrl and shift keys. 

9. Member split functionality: 

a. The quick member function has now been improved to identify and optionally split 
members which are intersecting; 

b. Splitting members with applied distributed, triangular or trapezoidal loads will now also 
split the loads automatically; 

10. Demonstration videos available on the CADS YouTube channel can now be accessed directly from 
the software through the Help menu. 
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Corrections made: 

1. Performance and export / import issues relating to exporting jobs as CSV files have been 

corrected; 

2. Issues relating to being unable to open .a3d files in A3D MAX have been corrected; 

3. Issues which produced error code 2 and error code 4 have now been corrected; 

4. An issue has been resolved whereby different results for the same parameter were produced by 

A3D MAX and SWMD; 

5. An issue relating to batch processed columns not producing any results has been fixed; 

6. An error with cut – copy and paste not working as expected has been fixed;  

7. An issue relating to auto-generated load from panels not being deleted has been corrected; 

8. The start and end width of overhangs are now changed based on the local axis of the panels;  

9. An issue when exporting to RC Column Designer occasionally resulted in the column width and 

depth being swapped. This issue has now been fixed; 

10. Various other small bugs have been corrected; 

11. Various ambiguous error messages have been clarified. 

Version 4.14 (Build 639): May 2014 

Enhancements: 

1. In the print layout a new option “Maximum effects for member types” has been included under 
“Analysis Results”. Choosing this option, envelope results for each member type will be shown in 
the report. 

2. The axis triad showing the global X, Y and Z axis is included in the diagram output when visible in 
the main view. 

3. An option to display the results dialog after analysis is now available from A3DMAX > File > 
Configure > Preference > Options. Selecting this option will turn on the results display after 
analysis and unselecting this option will turn off the results display. 

4. The speed of DXF import for large jobs has been substantially improved. 

5. In the Eurocode version, calculation of effective area and section modulus for slender circular 
hollow sections (CHS) is now based on the NCCI guidance ‘Design recommendations for hot-
finished elliptical hollow sections’. 

6. The straightness tolerance for joined member creation with design/check has been relaxed. 

7. Eurocode concrete grades have been added to the materials editor. 

8. RC design results are now updated in A3D MAX when a Details file is edited. 

Corrections made: 

1. Under a certain sequence an error message was displayed during the copy/paste of members. 
This has been corrected now.  

2. A customer job crashed when converting the project from BS to Eurocode. This is fixed now. 
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3. Under certain sequences, the preset view did not remember the captured zoom level. This is fixed 
now. 

4. A customer job had an issue importing CSV files with user defined sections. This has been fixed 
now. 

5. In some sequences, swapping between the tabs in the tabular results added a duplicated row in 
the limits tab. This is fixed now. 

6. For a specific customer job the maximum bending moment was not shown graphically. This has 
been fixed now. 

7. Under a certain sequence, a spurious message “Invalid argument" was shown when editing fields 
in the Member type editor. This is fixed now. 

8. If a member type with huge section properties or a joint load with a huge value was input the 
program crashed during analysis. The crash has been fixed and a suitable warning message 
provided in the ‘Error Log’. 

9. In certain circumstances the program crashed when performing plastic analysis calculations. This 
is fixed now. 

10. Under certain sequences, loads applied to the panels were not transferred to the model. This is 
fixed now. 

11. Problems with displaying panel loads are corrected now. 

Version 4.13 (Build 618): December 2013 

Enhancements: 

1. The display of graphical load values has been improved. Up to three decimal places of load values 
will be shown. 

Corrections made: 

1. Sloping members with haunch sections had a problem when auto design is performed. This is fixed 
now.  

2. In certain circumstances, the printed versions of captured pre-set views are not quite as per the 
displayed views. This has been fixed  

3. In certain circumstances, changing the radio button or swapping between the result page tabs 
generated a duplicated row in limits tab. This is fixed now. 

4. In certain conditions, point loads applied on the edge of panels were not distributed / ignored. 
This is fixed now. 

5. Editing of design group name was formerly allowed only if the groups were in collapsed state. Now 
this is fixed.  

6. Deflection results graphics for some member were overlaid making it difficult to read. This is 
corrected now.  

7. Several problems with printing/preview of pre-set views have been corrected.  
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8. In A3Dmax Euro version, steel member check was checking the deflection limit to global deflection 
rather than member deflection. This is fixed now. 

9. Problems with printing order occurring in some sequences have been corrected.  

10. Problems with the default load category type names when switching between BS and Euro design 
codes are fixed now.  

11. In certain conditions, junk values were observed when members with haunch sections are were 
analysed. This is fixed now.  

Version 4.12 (Build 604): February 2013 

Enhancements: 

1. The former immediate updating of panel co-ordinates is now suppressed. The software will wait 
until the user changes the entire corresponding panel co-ordinates and will prevent the panel 
from getting deleted. These panel co-ordinates will be updated automatically, once the user clicks 
on the “close” button of the joint editor or joint properties dialog. The “Undo” option is 
implemented for this feature.  

2. Design object and member references are now displayed in the intermediate and detailed design 
output results for steel design.  

3. The option to delete the "restraint set" is now implemented for the EC version of the steelwork 
member checking software.  

4. The load combination reference is now displayed in Design & Check result page for both BS & 
EURO versions of the steelwork member checking software. 

Corrections made: 

1. Clicking on Edit design parameters generated an “incorrect path” message when the job name 
was saved with a space before the suffix. This is fixed now.  

2. In certain circumstances members exported from A3D MAX generated a spurious error message - 
“number div not consistent”. This is now fixed.  

3. Reaction results were not in line with the table column in the previous versions. Now this is 
corrected. 

4. In certain circumstances the program crashed when changing the panel load distribution type. 
This is fixed now.  

5. In certain conditions, the panel area loads were not displayed in partial view. This is fixed now.  

6. Maximum axial force was displayed incorrectly when the envelope option was ticked. This is now 
fixed.  

7. Diagram values in the Elements member type editor were clipped under certain DPI settings. This 
is now fixed.  

8. Incorrect warning message sometimes appeared when accessing the Member attributes page. 
This is now fixed.  
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9. In certain circumstances, Quick member mode stayed active after closing it. This is now fixed.  

10. A job created in certain versions of A3D MAX crashed when the analysis was run in a later version. 
This has been fixed.  

11. Under some sequences a job crashed when converting the project from the BS version to EC. This 
is fixed now.  

12. In certain cases an RC column group was not created for internal columns. This is fixed now.  

13. Minor changes in the deflection utilisation ratio were observed in the design and check results 
dialog when returning from Details (transferring from SWMD to A3DMAX) under some sequences. 
This is fixed now. 

14. The Help file has been updated to describe and clarify area load distribution on an inclined panel.  

15. In a particular sequence design/check results were not performed for custom sections. This is fixed 
now.  

Version 4.11 (Build 581): June 2012 

Enhancements: 

1. A new option is provided in the load combinations page to show any zero/0.000 as a blank/empty 
field.  

2. The `undo’ option is now available for the “remove all” option in the load combination page.  

3. An option to toggle design group objects i.e. bases and pile caps has been implemented. 

Corrections made: 

1. A problem has been resolved whereby in the Eurocode steel member check module torsional 
buckling check produced inconsistent results for a simply supported member with end moments 
and a member within a frame with the same moments.  

2. When the option "New Window" for windows of a model was selected graphical distortion was 
observed in certain circumstances. This is now fixed.  

3. In certain circumstances, the print out option was greyed out when the diagram option was ticked. 
This is now fixed.  

4. In certain circumstances an error message was shown when opening the design results due to the 
registry not updating. This is fixed now.  

5. Slow response when selecting properties for members and joints has been fixed.  

6. In certain circumstances panels got deleted when rotating the model by 180 degrees. This is fixed 
now.  

7. Captured views showed all the load cases irrespective of selected load combination. This is fixed 
now.  

8. Under certain circumstances, error status was shown for Mass/RC base design results when the 
job was created in Euro code with UK annex. This is fixed now.  



A3D MAX Release Notes 

 
   

 
10    Copyright © Computer and Design Services Limited 

9. In certain circumstances, the printed versions of captured preset views are not quite as per the 
displayed views. This has been fixed.  

10. In certain circumstances the program crashed during the `spilt member’ operation. This is now 
fixed.  

11. In certain operational sequences, selection of a spring support did not allow a stiffness value to 
be entered. This has been fixed now.  

12. Clicking on Edit design parameters generated an “Incorrect path” message when the job name 
was saved with a space and some characters. This is fixed now. 

Version 4.10 (Build 546): June 2011 

Enhancements: 

1. A new feature to automatically generate equivalent horizontal force (EHF) to Eurocode has been 
implemented. 

2. Eurocode 2 RC design parameters can be specified in the A3D nationally determined parameters 
dialog for use with integrated design and single export.  

3. The results dialog now opens highlighting the results for the joint/support/member currently 
selected in the main view.  

4. An option to display only the maximum result labels graphically has been introduced.  

5. A new option has been implemented to show/hide the project data dialog when the application 
is opened.  

6. Labels of orphan joints are now listed in the error log.Send to mail recipient has been improved 
to send the project data folder along with the .a3d file.  

7. Send to mail recipient has been improved to send the project data folder along with the .a3m file. 

Corrections made: 

1. Under BS codes, Design/check results, steelwork design, if Details is selected for a member and so 
calculated in CADS SWMD, the results are now reported back to the Design & check results dialog 
with the Design parameter file reference updated.  

2. In certain circumstances, on export to RCBD a spurious “Invalid end moments” warning was 
generated. This is now fixed.  

3. Jobs created in certain versions of A3D MAX was crashing when the load combination dialog was 
opened. This has been fixed.  

4. In certain circumstances, for old jobs the saved printout selection was ignored and the diagrams 
were not printed. This has been fixed. 
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Version 4.01 (Build 530): March 2011 

Enhancements: 

1. A new feature to display the load values in the view has been implemented. It can be controlled 
through a load label toggle. 

2. The CSV import feature has been updated to support member loads and panel loads.  

3. The print preview dialog has been redesigned supporting grouping of print data for quick access.  

4. Reuse of design data (SWMD templates) is now allowed for integrated steel design to BS 5950-1.  

5. Clicking on the `Edit design parameters’ button in the Design results dialog allows changes to be 
made to member function, deflection limits and other design parameters for selected members.  

6. SW-EC3 detailed output is improved with more information like notes, warnings, error messages 
and references.  

7. SW-EC3 checks for unrestrained torsional and flexural-torsional buckling under axial compression 
are now suppressed in cases where they cannot occur due to intermediate restraints to the 
relevant buckling length.  

Corrections made: 

1. Fixed defects in haunch properties and cross section classification for steel design to Eurocode.  

2. The “Applied and reactive forces/moments do not equate exactly” message was sometimes 
launched displayed when inappropriate. This is now fixed.  

3. Undo operation was not working properly in some cases. This has been corrected.  

 

Version 4.0 (Build 513): September 2010 

Enhancements: 

1. A new functionality ‘project data’ has been introduced which enables the user to specify the 
design code at the project level. Currently British Standards and Eurocodes are supported.  

2. With Eurocode it is possible to choose between predefined UK national annex and default 
Eurocode data. Other national annexes are supported through the user defined option in the 
nationally determined parameters dialog.  

3. National annex data are saved with the job. Hence by creating a template with user defined 
national annex data it is possible to reuse the same across new projects.  

4. Integrated design functionality is now improved using the ‘project data’ functionality. The file 
management is done by the program relieving you from the hassle of locating the template/details 
file.  
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5. It is now possible to automatically generate load combinations to Eurocode (EN 1990). This 
functionality comes in the form of a wizard which has the necessary options and a brief 
explanation of the Eurocode terms to make the appropriate choice for the design.  

6. Integrated design of steel members to Eurocode (EN 1993) using UK national annex or default 
Eurocode data is introduced for the first time. With EC3 it is possible to specify the lateral 
restraints as part of A3D MAX data and also view detailed results from code check or auto design 
within the same application.  

7. The initial version of steel member design to EC3 supports uniform, tapered and haunched 
members with rolled or welded cross-sections. The new Eurocode steel grades are supported with 
the same. Other enhancements include the support for both normal and lateral buckling restraints 
and torsion for closed cross-sections.  

8. Concrete element design to Eurocode 2 (EN 1992-1) is fully supported for RC Beam Designer, RC 
Column Designer, RC Pad Base Designer (including EC7) and RC Pile Cap Designer. In common with 
the existing BS 8110 versions, the Eurocode option can be used in standalone mode, as a single 
object export from or integrated within Analyse 3D and A3D MAX.  

9. The direct single export and integrated design of bases for columns not aligned to the global X and 
Z axes has been enhanced so that bases align with the column axes instead of the global axes.  

10. The graphics system has been updated to now fully support Windows 7. 

Corrections made: 

1. Corrected an inconsistency whereby when exporting to RC Base Designer data for a support to a 
column with 90 degree orientation, the value of moments about the two principal axes were 
interchanged. 

Version 3.53 (Build 470): November 2009 

Enhancements: 

1. The input ‘Overall design member length’ has been introduced in the ‘Member attributes’ dialog 
for ‘partial fixity’ end condition. This input is intended to help specify correct partial fixity 
parameters for members which are subdivisions of the real design members such as primary beam 
segments. 

Corrections made: 

1. The error message "large differences in displacements" was incorrectly reported for certain 
members with both ends partially fixed when ‘p-delta’ effects were included in the analysis. This 
has been corrected. 
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Version 3.52 (Build 460): August 2009 

Corrections made: 

1. While exporting members to RC products, there were some issues in checking dongle 
authorization. This has been fixed. 

Version 3.51 (Build 459): July 2009 

Corrections made: 

1. In version 3.50, the ‘Automatic panels’ option did not work properly (the panels were duplicated). 
This has been fixed.  

2. When `lift off supports’ was selected in Analysis options, the `Summation check’ in the Analysis 
results dialog could be corrupted by the results of intermediate calculation iterations. This has 
been corrected so that only the final summation results are saved. 

Version 3.50 (Build 454): April 2009 

Enhancements: 

1. A3D MAX has been enhanced to support batch processing of beams, columns and supports by RC 
Beam Designer, RC Column Designer and RC Pile Cap Designer respectively using the Design dialog.  

2. ‘Combination options’ for RC pad base designer in the ‘Load combinations and categories’ dialog 
has been modified by merging ‘wind uplift’ and ‘wind down’ to ‘wind’ and replacing ‘Normal’ with 
‘Non-wind’. The up and down loading condition is now detected by the base designer program.  

Corrections made: 

1. When specifying patch loads in a panel whilst the frame was in rendered mode view, the patch 
load did not appear. This has been fixed.  

2. In certain circumstances P-delta related warnings appeared even though P-delta was not 
activated, this has been corrected. 

3. The program did not remember the “start at page” in the print layout dialog, when the job was 
reopened. This has been fixed.  

4. In certain conditions a spurious ‘Large displacements’ error was reported when opening the 
”Results graphs” dialog. This has been corrected. 

5. In analysis with Pdelta effects, when a pin ended member was internally removed by the “Euler 
load exceeded” condition, the program incorrectly displayed the warning “orphan joint(s) have 
been supported”. Now the warning is suppressed in this condition.  
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6. 6) In a certain conditions, when validating the plastic properties of members, the data were not 
taken correctly, hence the program displayed “Plastic invalid Kx/Nx values” error message. This 
has been fixed.  

7. In steel member design batch processing the slenderness correction factor (nt) formula has been 
corrected as per Annex G.4.3 of BS 5950-1:2000 Amendment 1 (2007) in accordance with 
Corrigendum 2 (2008).  

8. In certain conditions, the program was not taking the correct deflection limit value from SWMD 
template file. This has been fixed.  

9. In certain conditions “Member type section” was not updated correctly when editing the member 
type section in “Member Type Editor” dialog. This has been fixed. 

Version 3.44 (Build 420): July 2008 

Corrections made: 

1. The changes related to self weight category explained in point 1 under ‘Enhancements’ of Version 
3.66 was not getting updated to the user modified ‘defs-a3d.cct’ file. This has been corrected. 

Version 3.43 (Build 418) July 2008 

Enhancements: 

1. When the ‘Automatic Self Weight’ option in the Load Editor page was ticked the self weight was 
always added to Dead load category. When the partial safety factor for Dead load category was 
manually set to zero the self weight was ignored. To avoid this situation a new load category called 
‘Self Weight’ is introduced. When the self weight option is ticked the PSF is set to 0.000. The PSF 
value can be edited within a range of 0.000 to 99.000 When the option is un-ticked the PSF field 
will be greyed out with a value of 0.000. While opening the jobs created in older versions the 
following warning message will be displayed.  

2. “This job was created with an older version of the software prior to v3.66 when the treatment of 
self weight was changed (see release notes). Self weight is now a separate load category from 
dead load so you will have to enter the appropriate partial safety factors in the load combinations 
dialog in order to get consistent results.”  

3. The slenderness correction factor (nt) formula in Annex G.4.3 of BS 5950-1:2000 Amendment 1 
(2007) is modified in accordance with Corrigendum 2 (2008).  

Corrections made: 

1. 
as 0.0 even though they were not matching exactly. This has been corrected. Also the existing 
warning message "Forces and moments don't equate - Frame is suspected mechanism" displayed 
when applied loads are not equal to reactions, is modified as "Applied and reactive 
forces/moments do not equate exactly".  
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2. When the limit state in the load combination dialog was changed from ULS or SLS to Ignore or set 
to Ignore, on selecting the ‘Graphical Results’ page with any ‘Graph Type’ ticked the application 
crashed. This has been fixed. 

3. In a customer’s job ‘Large displacements’ error was reported when ‘Envelope’ option was selected 
with ‘Moments’ as graph type. This has been corrected. 

4. A display problem in the main view with toggle member (support & panel also) on/off while 
switching between stick model and rendered model is fixed.  

5. Views captured with any options in the ‘Graphical Results’ dialog selected was not displayed 
properly when the captured view was viewed again. This has been corrected. 

6. Views captured with few members displayed in red colour indicating that those members were 
selected, were not displayed in red colour when the preset view was viewed again. This has been 
corrected.  

7. When a preset view was captured with the diagram or text very close to the top border of main 
view, it was slightly cut off in the Print/Preview. This has been corrected.  

 

Version 3.42 (Build 416) April 2008  

Corrections made: 

1. The problem of ‘internal joints’ warning message that occurs in background calculation during 
panel load distribution has been corrected.  

2. In P-Delta analysis when a Tension only member was exported directly to SWMD, the program 
displayed ‘End2 deflection’ errors. This is corrected such that, the program suppress the deflection 
check for Tension only members in P-Delta analysis.  

3. The calculation of torsional constant ‘J’ of hollow sections in member type ‘Elements’ was wrong. 
This has been corrected.  

4. When the template reference file (a SWMD job file created through Details… option) was deleted 
the design results were not invalidated. This has been corrected so that when the template 
reference file is not available the results are now shown ‘n/a’.  

5. Changing the construction type of bases from Reinforced Concrete to Mass Concrete by setting 
the top and bottom bar to ‘Not required’ in the Bar Arrangements page was not properly 
recognised by the application and caused many error messages. This has been corrected.  

Version 3.64 (Build 414) February 2008  

Enhancements: 

1. In the Frame generator>Lattice girder page the bottom chord slope for duo pitch girders has been 
enabled to increase the scope of this feature.  

2. One extra digit is added to the support reactions (Py) in the results page such that the program 
now shows vertical reaction values up to 6 digits i.e. 999999.999 KN. 
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3. The tool tips for autogenerated loads from panels have been enabled for easy reference. 

Corrections made: 

1. In plastic analysis when the collapse load factor for a load combination was less than 1.000 the 
program could not calculate member effects for that load combination. This generated 
inappropriate error messages when it tried to Check, Design, Detail or direct export to SWMD. 
Hence if any active load combination has a collapse load factor less than 1.000, Check, Design, 
Detail and direct export to SWMD are now disabled and a warning message is displayed to explain 
the situation.  

2. In the configuration page the input for "Maximum utilisation for ‘overdesign’ report” ranges from 
0 to 1. This is now modified to express in percentage terms with range from 0 to 100, as described 
in the Help. The default value is set to 80 which correspond to an utilisation ratio of 0.800.  

3. Editing of panel overhangs was allowed only through the overhang editor. This is now modified in 
accordance with the Help such that the overhang properties can be edited through the panel 
editor page also.  

4. The display selection in the load combination page recognized only positive partial safety factors. 
This is corrected such that the display selection now recognizes –ve partial safety factors also.  

5. If an unusually large value of partial safety factor was input the program displayed error messages 
during analysis. This is corrected such that the program calculation proceeds without interruption 
and just displays a suitable warning message if the situation occurs.  

6. When more than two members were selected to form Automatic panels and the selected 
members did not form a closed loop, the program displayed just an “OK” warning without 
explaining the reason. This is now corrected such that the program displays “Selected members 
do not form a closed boundary” message if this situation occurs.  

7. Since the current version of A3D MAX does not support the automatic self weight of panels the 
“Automatic self weight” option in the load editor page is renamed as “Automatic member self 
weight(except panels)” and a appropriate note is displayed in the panel loads page.  

8. The occasional disappearance of the main view in certain operating systems has been corrected.  

9. Problems with printing/preview of preset views have been corrected.  

10. Earlier versions of A3D MAX did not recognise the load categories colour set for area loads in the 
Load combination & categories page. This has been corrected.  

11. Selecting the ‘Envelope’ option in the ‘Results > Effects’ page caused an application crash. This has 
been corrected.  

12. If a member type with huge section properties was input the program displayed error message 
during analysis. This is corrected such that the program calculation proceeds without interruption 
and displays a suitable warning message in the ‘Error Log’.  

13. The deflection check was not included while doing ‘Check’ design in the Design results page. This 
has now been included and the program now displays the utilisation ratio for deflection also.  

14. If ‘Apply grouping’ option was selected in the ‘Frame generator’ page the program provided an 
incomplete path for the template i.e. ‘\defaults.smd’. Due to this ‘Failed to read template file’ 
error occurred. This has now been corrected.  

15. If the member type ‘Non-prismatic’ was input the program displayed an incorrect graphical 
representation of that member in render mode. This has been corrected.  
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Version 3.40 (Build 412) December 2007 

Enhancements: 

1. CADS A3D MAX is made compatible with Microsoft Windows Vista.  

2. The new (2006) range of steel sections from Corus (Advance sections, Celsius 355, Jumbo 355 and 
Hybox 355 sections) are included in the Steel section library.  

3. The old start up image has been replaced with a fresh new image.  

4. The CADS SMART Designer Launcher has been replaced with the new CADS System – Analysis, 
Modelling and Design Launcher bringing all CADS structural analysis and design products together.  

5. The treatment of Pinned-Pinned members for P Delta analysis has been improved. Member axial 
stiffness will be negligible once the Euler buckling load is exceeded except when the member P 
Delta behaviour is set to `suppressed’.  

6. Tension-only member analysis has been improved to better model the practical behaviour of 
tension-only cross bracing systems. 

7. The wording of instability and mechanism reports has been clarified.  

8. Tension-only members, compression only members and lift-off supports are now included in 
elastic critical load factor analysis. 

9. Faster response speed whilst selecting members or browsing through various dialogs for large 
structures.  

10. A ‘Print Title’ option is now provided in the ‘Capture preset view’ dialog to include/exclude the 
reference name in the printout based on tick/untick option chosen. By default this option would 
be ticked  

11. A ‘Design option’ field has been added in the ‘Design Results’ dialog for SW member groups to 
display the design selection criterion for a particular group.  

12. The configuration of text size/height in the main view and the printed view is separated through 
the options ‘Text height for screen views’ and ‘Text height for printed views’ respectively in 
File>Configuration>Preferences>Sizes.  

13. Base color is now configurable with the ‘Base’ and ‘Base Highlighted’ options added in 
File>Configure->Preferences->Colours Page. Also the rendering of supports is suppressed when 
bases are shown  

14. All the existing/saved jobs will open without the load graphics in the view. This saves the time 
taken to open jobs with many loads. However, for new jobs the load graphic button will always be 
toggled ON so as to visualise the loads upon their application  

15. As ‘Export to Word’ option is now available for text export in Print layout dialog, the ‘Word Macro’ 
option is removed and the dialog has been modified accordingly  

16. Copying and pasting of bases either individually or along with supports and members is allowed. 
Group selection of bases is also allowed for this functionality.  

17. Steel Work Member Design by ‘Least weight’ option improved to handle member groups with 
common design.  

18. ‘Tension only’ template added as SWMD template to handle any members having only the tension 
force. This will automatically suppress the Buckling check for the members.  
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19. The printing scale of joints increased to clearly distinguish between members and joints in the 
printout. 

Corrections made: 

1. RSEA 45x45x5 in UK6 was incorrectly designated in the Steel section library. This has been 
corrected as RSEA 45x45x4.5.  

2. Multiple instances of Double sections from the Steel section library were unnecessarily prevented 
without warning. This has now been corrected. 

3. A customer’s job which had narrow panels failed to include the panels in the analysis. This has 
been corrected by removing an unnecessary check. 

4. Spurious ‘orphan’ joints were reported in a customer’s job due to removal of some directional 
members during analysis. The spurious reports have now been suppressed. 

5. Any selection in the main view was highlighted when printing the preset views, though no 
selection was made in the view at the time of capturing. The highlighting has now been 
suppressed.  

6. The display of loads for members which are nearly vertical was wrong. This has now been 
corrected and the direction of load graphic will respond correctly to the orientation of the 
member. 

7. The display of panel ribs in the render view for a customer’s job was wrong and the job was 
corrupted. The fault has been corrected and the job recovered. 

8. The preset view of a member captured in partial mode was not updated if the member is split 
later. This has been corrected and now the preset view will be updated properly.  

9. When a user template (.cct) is created and subsequently used, the Save/Save As option offered 
.cct extension. This has been corrected so that the template will now be treated as a new unsaved 
a3d job by offering .a3d extension  

10. The preset views were inconsistent as the views were picking the settings of the previous preset 
view. This has been corrected and the preset views will always retain the job settings currrent 
when the view is captured  

11. Exporting very large volumes of data to Microsoft Word was incomplete and hence failing. This 
has been corrected now. 

12. A customer’s job had corrupted panel display. The cause has been corrected now and the job 
recovered.  

13. For 2D frames the critical degree of freedom was reported incorrectly as the frames were treated 
as 3D when reporting instability. This is now corrected.  

Version 3.33 (Build 408): 

Enhancements: 

1. Copying and pasting of bases either individually or along with supports and members is allowed. 
Group selection of bases is also allowed for this functionality.  
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2. Steel Work Member Design by ‘Least weight’ option improved to handle member groups with 
common design.  

3. Common Design of Steel Work members belonging to a group containing Tension/Compression 
only members improved.  

4. ‘Tension only’ template added as SWMD template to handle Tension only members by 
automatically suppressing the Buckling check for the same.  

5. The printing scale of joints increased to clearly distinguish between members and joints in the 
printout.  

6. The time consumed in printing the member loads is reduced by skipping the unnecessary member 
loads generated through the panels. 

Corrections made: 

1. Headers went missing in the printout of a customer’s job. This has been corrected by readjusting 
the space below some tables in the printout.  

2. Jobs used to crash upon picking ‘Member Type’ in ‘Member Type Editor’ table whilst ‘Design 
Results’ dialog was kept opened. This has been corrected now.  

3. Base grouping wizard wasn’t accepting base group names with space characters. This has been 
corrected and any type of characters can now be included in the base group names.  

4. Bases were not created if the ‘Finish’ button is pressed before navigating till the end. Now it has 
been corrected so that a base group will be created when ‘Finish’ is pressed in between.  

5. There was a problem in creating a joined member through SW Grouping wizard due to wrong 
sorting of members. The sorting has been corrected now through a rational approach.  

6. When a new A3D MAX job is created through Windows Explorer, the job was reported as 
corrupted upon opening. This has been corrected now by treating the job as a new A3D MAX job.  

7. RC beam member types were displayed incorrectly in the rendered mode. This has now been 
corrected.  

8. A customer’s job was opening as a dot in the view. This incorrect view has now been corrected.  

9. The diagrams were drawn inverted in the printout of one of the customer’s job. This has been 
corrected by correcting the scaling of the diagrams in the printout.  

10. The print preview of the views for some jobs was half hidden even if a small portion of the view 
was not in focus. The scaling of the views has been corrected now to avoid this.  

11. The ‘Send To’ option in the File menu was sending the wrong temporary file to the mail recipient. 
This has been corrected now.  

12. When SW groups are created through the ‘Old Grouping’ method, the ‘Export to Designer’ icon 
remained enabled even without any selection in the view. This has been corrected now.  

13. Saving a .cct file as A3D MAX job (.a3m) through ‘Save As’ option in ‘File’ menu was a problem as 
this option was offering .cct extension in lieu of .a3m. This has been corrected.  

14. SWMD was not returning a template when ‘New’ template option was selected in SW grouping 
wizard and the job is saved by using ‘Save As’ instead of ‘Save’ in SWMD. This has been corrected 
to work in line with ‘Save’ option in SWMD.  
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15. The message conveying the template creation while opening SWMD through SW grouping wizard 
has been changed to convey the appropriate meaning.  

16. The Density field in the ‘Materials Editor’ dialog was not accepting some values within the range 
given. This has been corrected. 

Version 3.32 (Build 404) 

Enhancements: 

1. Instability Reporting Feature – this detects the instability within a frame and reports the unstable 
node and corresponding degree of freedom.  

2. The instability report is displayed in the error log.  

3. Frame mechanism during linear analysis and frame instability in second order analysis are 
discerned and reported appropriately in the instability report.  

4. The ‘Critical joint’ and ‘Critical degree of freedom’ are reported for elastic critical load analysis.  

5. Printout has been updated to include the critical joint and corresponding degree of freedom in 
elastic critical load analysis output.  

6. Deflection Reporting Feature – this enables setting of the deflection limits for members and joints 
and reports maximum deflections with violations, if any.  

7. The default deflection limits for joints and members are shown in the ‘Limits’ page of 
‘Configuration’ dialog.  

8. ‘Joint properties’ dialog includes the ‘Limits’ page to set up the deflection limits for joints.  

9. ‘Limits’ page is provided within the ‘Member Properties’ dialog to specify the member deflection 
limits.  

10. Member deflections are shown as ‘Global’ and ‘Relative’ deflections. Member ‘Relative’ 
deflections include the ‘Local Bowing’ and ‘One end deflection relative to another’.  

11. The ‘Limits’ page in ‘Results’ dialog reports the maximum deflections along with the limits set and 
the degree of violation of the same.  

12. Printout has been updated to include the deflection reporting output details.  

13. Base design (including direct link) upgraded to BS 8110-1:1997 Amendment 3 and BS 8666:2005.  

14. The redundant calculations while saving the jobs with plastic analysis and collapse analysis are 
avoided.  

15. Rendering of supports has been re-instated. 

16. Panel material types which are in use within a job are not allowed to be deleted.  

17. User entered member types other than the SW and SW Haunch are allowed to be shown in CSV 
members list.  

18. Messages in the error log are shown product specific.  

19. Printout has been modified to accommodate large joint coordinates and member references. 
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Corrections made: 

1. The member results for a SW group having ‘Tension/compression only’ members were not 
updated correctly and this has now been corrected.  

2. The DXF output for in-plane view for plan layout was shown inverted but this has now been 
corrected.  

3. There was a crash in the base grouping wizard due to the wrong placement of the message 
conveying the duplication of bases. The message has now been shown correctly.  

4. Calculation results were being cleared for any changes in the preset views although these would 
not affect the results. The results are now retained.  

5. The range used to check the validity of the joint coordinates was wrongly shown, now this has 
been corrected.  

6. The preset views were not registered correctly through the right click menu. This has now been 
corrected.  

7. Back to back channels and angles with zero spacing were wrongly treated as single sections. This 
has been corrected and these will henceforth be treated as double sections.  

8. SW group name in the SW grouping wizard was not accepted unless the wizard was navigated till 
the end, but this has now been corrected. 

9. The edge of a panel when split was not treated as a straight edge. This has now been corrected by 
adjusting the tolerance set for checking the straightness.  

10. Two adjacent panels, though lying in the same plane, were not allowed to be rigid in certain cases. 
This has been corrected by relaxing the tolerance.  

11. Creation of panels was restricted to some sequence of selection of joints. Now panels can be 
created by selecting joints in any sequence.  

12. Triangular panels were drawn distorted in some jobs, this has now been corrected. 

Current version known limitations 

1. Copy and Paste between multiple instances of A3D or two different jobs is not reliable. In addition, 
area loads cannot be copied at present.  

2. The Split Member function does not currently support the copying or splitting of loads to its 
constituent parts.  

3. The Mirror facility is not fully functional in that it does not copy objects and improvement needs 
to be made to the locating of the mirror plane.  

4. You are strongly recommended to use a 16 or 24 bit colour mode (rather than 256 colours) 
whenever possible. 

5. P Delta effects in partially fixed members will be ignored.  

6. P Delta effects in Non Prismatic members will be ignored.  

7. Partial end fixity cannot be used on Non Prismatic members. 

8. The reduction in design strength for sections with flange thickness greater than 16 mm is available 
for the standard steel grades 43, 50, 55, S275, S355 & S460 only.  
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9. The following linked or integrated code checking software modules do not currently cater for 
torsion moments produced by frame analysis: 

 SWMD-Steelwork member designer;  

 SWMC-Steelwork moment connections;  

 RCBD-RC beam designer;  

 RCCD- RC Column designer;  

 RCPBD- RC Pad base designer;  

 RCPCD- RC Pile cap designer.  

Torsion moments will be ignored by these programs. Refer to Analysis options > Torsionless 
analysis which provides the facility (where appropriate) to neglect torsional stiffness of members 
in analysis as in traditional design practice. 

Post-installation notes 

Once you have installed CADS A3D MAX, it must still be authorised before it can be used. The 
procedure is the same for stand-alone and network installations. For network installations, you should 
ensure you have the necessary permissions to write to and create directories on your server drive 
before starting. 

To start CADS A3D MAX, select the 'CADS System - Analysis, Modelling & Design' icon from the Desktop 
or 'CADS' program group (Start->Programs) and then click on the ‘A3D MAX’ button from the ‘Analysis’ 
tab. If the program is not authorised the licence manager will be invoked automatically, through which 
the licence can be requested. 

At any time, a licence can be requested by pressing the "Licensing Wizard..." button and the 
application can be licensed by pressing the "Enter/Import Licence Codes..." button of the CADS Licence 
Manager.  

For details refer to the CADS Licence Manager help. 

If you have any questions about this procedure, please contact our Technical Support Department 
who will be happy to help. 

 

Technical support and Authorisation codes:  

Telephone: +44 (0)1202 603733  

Email (Support): support@cads.co.uk  

 

Other useful addresses are: 

Email (Sales): sales@cads.co.uk 

Website: http://www.cads.co.uk  

Fax.: +44 (0)1202 658549 

mailto:support@cads.co.uk
mailto:sales@cads.co.uk
http://www.cads.co.uk/
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Version history 

Version information prior to those versions listed within this document can be found in the file 
‘readme.txt’ within the application folder. 


